Create an education wiki using PBwiki

Go to http://pbwiki.com
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Add the information requested here to sign up for a PBwiki account.
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Once you have followed subsequent directions to activate your account, go back to http://pbwiki.com. 
Click on the Create a Wiki button and then click on Log in to access your PBwiki account.
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Enter your email address and password in the appropriate text boxes. Then click the Log in button.
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Think of an easy to remember name for your wiki and enter it in the appropriate text box. Keep the name as short as possible. Be sure to click the radio button in front of the words ‘For education.’ Then click the Create my wiki button.

If the name you selected is already in use, you will be asked to try another name.

Once your wiki name is approved, you will be taken to a page where you may change security settings. Decide who can view and edit the wiki. For this activity, the default settings are fine. (You can always change them later.) Click that you agree to the terms of service and click on the Take me to my wiki button.
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The first time you view your new wiki’s FrontPage you will see links to several helpful resources. You can delete these links later, but for now, we will work around them.
Take a few minutes to review the labels on this illustration for a new FrontPage.
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FrontPage Basics

The following information comes from the online PBwiki manual. The areas referenced are shown in the illustration on page 4 of this handout.
The Main Panel

Wiki title and/or logo

This is where you will find the title of your wiki. If you've uploaded a logo, it will appear in this area. Some things to note: 

· The wiki title and logo function as a "Home" button and can always be clicked to return you to the FrontPage.

· The wiki title can be changed from the "About This Wiki" section of the Settings page.

· After uploading a logo, the image replaces the wiki title on each page.

Page info and tabs 

· The View tab shows you a web page on the wiki. This is what users see first when they encounter your wiki. 

· When you navigate around a wiki, you are automatically in View mode.
· When you click the View tab while in Edit Mode, PBwiki prompts you to save the page and returns you to View Mode.

· The Edit tab puts you into Edit mode and allows you to modify the contents on the page. The editor is covered in much greater detail later in this handout.
· Page title - Choose the page title when you create the page.  Page titles can be modified in Edit mode by clicking on the small "ab|" icon that appears to the right of the title or from the Pages & Files area by using the "Rename" link that appears below the name of each page.

· Last edited by - shows who last edited the page and when it was edited.

· Page history 

· This is where independent page revisions are stored. Here you can browse, compare, or revert to previous page revisions.  If you like, you can also delete one or more revisions.

· You can also access a page's history from the Pages & Files area by clicking on a linked number in the "Revs" (Revisions) column.

Hide/Reveal Right Panel
Sometimes, you might want to expand your wiki's main content area to better view a spreadsheet, image, or table.  You can effectively accomplish this by hiding the Right Panel.  Toggling the small, triangular button that sits to the right of the View & Edit tabs hides/reveals the Right Panel, which is discussed in the next section of this handout. 
Page body 

This is where all the text, images, plugins, and general content of a wiki page appear. You can be as creative as you want when you build a page!

 

Comments

You'll see comments displayed in chronological order in this section. Comments are limited to straight text and can be deleted by users with Editor or Administrator level permissions. 

· Comment counter- This reflects the number of comments on the page.

· Comment image - If you've uploaded an image to your PBwiki Account, it appears here when you make a comment.  If no profile picture has been uploaded, this image defaults to a tasty PB&J sandwich.

· Commenter name - The name that you've identified in your PBwiki Account appears here.

· Timestamp - This displays the "local time" the comment was made (i.e., relative to the viewer's local computer time settings.)

Footer 

· Terms of Service - Please Read These!  They are easy to understand and incredibly important!

· Privacy Policy - Please Read This, Too! We take your privacy very seriously.

· RSS feed - This allows you to subscribe to an RSS feed for the wiki.

· Contact the owner- This allows you to get in touch with the person listed as the wiki's owner.
The Right Panel

 Hiding/Revealing the Right Panel
Sometimes, you might want to expand your wiki's main content area to better view a spreadsheet, image, or table.  You can effectively accomplish this by hiding the Right Panel.  Toggling the small triangular button that sits to the right of the View & Edit tabs hides/reveals the Right Panel. 

Account info 

· Email: This is the primary address for the account you're using when you log in to the wiki. To change this, you need to visit the Profile page of my.pbwiki.com.

· Account: This link takes you to the Profile page of my.pbwiki.com.

· Sign out: Clicking on this link signs you out of your PBwiki Account and brings you to the my.pbwiki.com login page. 

Wiki tools 

· Create a page - Allows you to create a new page.  Only viewers with at least Writer-level access are able to add pages to your wiki. 

· Upload files - Following this link brings you to the "All Files" view of Pages & Files area.  To upload a new file or file revision, begin by clicking on the "Upload files" button.  You must have at least Writer-level access to upload files.

· Front Page - Returns you to the FrontPage of your wiki from wherever you are.

· Pages & Files - Allows you to view pages and download files.

· Settings- Takes you to the Settings page. This link is not visible unless you have Administrator-level access to the wiki.  
· Help - Takes you to the PBwiki Manual (what you are reading now) and other resources.

Page tools 

· Put this page in a folder/Put this page in a different folder - allows you to sort the page into an existing folder.

· Add a tag - Allows you to add a keyword tag to the page, which can be helpful for organizing and finding pages.   

* Note: Each of the following tool boxes can be minimized by clicking on the small (^) button that sits in the upper-right corner of each box, clicking on the button again maximizes the tool box.

SideBar: This is a special wiki page that appears on the right panel of your wiki.  You can edit the SideBar by clicking on the "Edit the sidebar" link.  Because the Sidebar appears on every wiki page, it's a great place to insert important page links to provide users with convenient navigation of your wiki.
Folders: Wiki pages can be placed into folders, and doing so is one way to better organize your wiki.  
Share this wiki: Enter email addresses here to add users to your wiki with Writer-level permissions.  
Recent wiki activity: Lets you know the most recent actions on your wiki.  Click on "More Recent Activity" for a more detailed list, or sort the "All Pages" view of your wiki's Pages & Files area by the "Last changed" column for a comprehensive look at recent page activity.

Editing Basics

The following information comes from the online PBwiki manual.
Editing a page

To edit a page on your wiki, simply click the "Edit" tab at the top left of your screen or hit the "E" key on your keyboard.  Make your edits and then click "Save" to finalize and publish those changes.

What is the Point-and-Click editor?

The Point-and-Click editor offers a simple way to create wiki pages. You can edit pages just as you would if you were doing word processing. In this WYSIWYG (what-you-see-is-what-you-get) editor, text and graphics appear exactly as when viewed on the wiki page. Even better, you can use PBwiki Plugins to easily insert a shared calendar, a YouTube video, stock chart, photo slideshow, or almost anything else.

Format Text Tools

Below is the current selection of tools available in the Editor's toolbox.  You may recognize some of the tools, as many of them are universal tools used in word processing and other WYSIWYG programs.  You can add emphasis to text by using the Bold, Underline, Italic tools.  Striking through text allows you to mark mistakes or changes that you've made.
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Bold, Underline, Italicize, and Strikethrough (Style buttons)
To use these formatting tools, simply select the text you want to change, and click the button on your Editor toolbar.  If you'd like to remove the formatting, simply select the text and click the appropriate button to undo the formatting.  For example, to remove the Bold formatting from a text, select the bolded text and click the Bold button on the Editor toolbar.
Text Color
There are two buttons which let you control the foreground and background text color.  You can use text color to make your text stand out, or to simulate a highlighter.
Bulleted and Numbered Lists
To create a bulleted or numbered list, simply type the content of the list first, pressing Return or Enter at the end of each item.  Then select all the contents of the list and press the appropriate button to bullet or number the list.
Once you've made a bulleted or numbered list, there are a few options you can set for each kind of list.  Simply right-click (or Control+click on the Mac) the listing you want to change and select "Bulleted List Properties" or "Numbered List Properties" to set the different options. 

 

For bulleted lists, you can set the bullet markers to be empty white circles, filled discs, or squares:

For numbered lists, you can set the kind of numbering system, and where that numbering starts.

Indentation and Text Alignment

For greater control of your page content's layout, you can set indents and align text, images, and plugins either left, center, or right.

Copy and Paste Tools

You can use the copy and paste tools to move links or page content from one wiki page to another. 
Pasting Safely

 

When you want to add content from an external source to your wiki, sometimes pasting is an easy way to do this, but please be aware that there's a safe way to paste information.  Pasting text, tables, or other information from MS Word, Excel, or other websites can insert a significant amount of HTML code that can interfere with your wiki page's code and cause undesired effects.

 

Pasting Text
To safely paste text into your wiki page, please first paste the text into Notepad (for Windows), TextEdit (for Macs, need to choose plain-text format setting) or another plain-text editor and then copy the plain text and paste that into your wiki.  Running text through the plain text editor strips the information of any formatting or other HTML that can upset the proper functioning of your wiki page.

 

Adding Tables
The safe way to add a table from MS Excel (or another spreadsheet program) is to use your wiki's Spreadsheet plugin. 
 

Adding Images

To safely add images from other sources to your wiki, please upload the images and then use the "Images and files" tab in the "Insert Links" Page Tool that appears on the right-side of The Editor screen.  

 

Adding Sounds or Video

You can use available plug-ins to safely insert sounds or video to your wiki page.  
Special Tools
Undo Button: Make a mistake or aren't satisfied with the change you just made?  We've got you covered with the Undo tool (or Ctrl-Z).  This button is disabled if there is nothing to undo in the editor.

Insert Link Button: The Insert/Edit Link tool allows you to easily insert links to wiki pages, folders, external URLs, or e-mail addresses. 

Insert Table Button: Use this tool to create a new table.  To edit an existing table, simply right-click (or Control+Click on Mac), to edit the Table properties.

Insert Horizontal Line Button: The Horizontal Line tool allows you to make clear separations between different sections of content on your page. 

Remove Formatting Button: Removing Formatting will set selected text back to default formatting. 

Insert Plugin Button: The Insert Plugin tool allows you to select from a number of productivity and enhancement plugins.

Click this button to get started.





Click here to Log in.
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